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Executive summary 
 
Intel Corporation (Intel) commissioned Principled Technologies (PT) to run a set of performance tests on two 
pairs of built-to-order Acer laptops: 
 

• Acer TravelMate 4402WLMi (with an AMD 
Turion 64 ML-30 processor; $1,099 at time of 
purchase), which we compared to an 

• Acer TravelMate 4062WLMi (with an Intel 
Pentium M 740 processor; $974 at time of 
purchase) 

• Acer TravelMate 4404WLMi (with an AMD 
Turion 64 ML-34 processor; $1,199 at time of 
purchase, but $1,149 on 03/03/06), which we 
compared to an 

• Acer TravelMate 4202WLMi (with an Intel Core 
Duo T2300 processor; $1,274 at time of 
purchase, but $1,099 on 03/03/06) 

 
The goal in choosing the systems was to find units as 
close in price and configuration as possible.  
 
The goal of the testing was to gauge the performance 
and energy consumption that laptop buyers would 
experience on systems they purchased online from 
such well-known sites as www.newegg.com using five custom performance tests. Intel identified the test 
systems, tests, test procedures, and test settings. PT purchased and set up the systems, and PT executed all 
tests. We ran performance tests using the following applications: 
 

Performance test applications 

• Adobe Photoshop Elements 4.0 with 
Adobe Premiere Elements 2.0 

• Apple iTunes 6.0.3 

• InterVideo iVideoToGo for PSP 
• Microsoft Windows Movie Maker 2.1 
• Pinnacle Studio 10 

 
Appendix A provides the purchase price of all four systems, and Appendix B details their configurations. 

Test results 
Tables 1 and 2 summarize the performance results and power measurements of each test. Each result is the 
median of three runs on each system. (In the event of a tie we chose the run with the higher power 
consumption. If the power consumption score was also tied, we then chose the first run we executed with 
those scores.) For these performance and power measurement tests, lower scores are better because they 
represent the time or the power the system required to complete each workload.  
 
We used the Intel Power Acquisition Recording Kit (iPARK) in the power measurement tests. The iPARK 
device is an external unit that connects to a host computer through a USB cable. It also has a DC power 
cable that powers the system under test. We used the iPARK device to monitor the average DC power 
consumption of each system while under load. We then multiplied iPARK’s average DC power score by the 

Key findings 
 

 The Intel Pentium M 740 processor-based 
system ran from 7 to 23 percent faster than 
the AMD Turion 64 ML-30 processor-based 
system on all performance tests. 

 The Intel Pentium M 740 processor-based 
system consumed from 66 to 86 percent less 
power than the AMD Turion 64 ML-30 
processor- based system during all 
performance tests.  

 The Intel Core Duo T2300 processor-based 
system ran from 36 to 100 percent faster 
than the AMD Turion 64 ML-34 processor-
based system on all performance tests. 

 The Intel Core Duo T2300 processor-based 
system consumed from 133 to 219 percent 
less power than the AMD Turion 64 ML-34 
processor-based system during all 
performance tests. 
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time the workload took to complete to calculate the Workload Energy Consumption (WEC) in Watt-seconds. 
We divided the WEC Watt-seconds score by 3600 (the number of seconds in an hour) to calculate the WEC 
Watt-hours we reported below.  
 
Because screen brightness can affect the amount of power a system consumes, for each pair of comparison 
systems we set the brightness to be as close as we could make it to the brightness of the dimmer of the two 
systems. Consequently, each Intel-based system was actually slightly brighter than its AMD-based 
comparison system. The nits measurements in parentheses below each system name in Table 1 and Table 2 
give the tested brightness for each system.  
 
In the rightmost column of each result set, we compare the median results of the systems. We calculate this 
comparison by dividing the AMD-based system’s score by the Intel-based system’s score. Consequently, 
comparative results above 1.00 indicate tests on which the Intel-based system performed better or was more 
power-efficient, and those below 1.00 indicate tests on which the AMD-based system performed better or was 
more power-efficient. See Appendix C for the detailed results of each test run. 

Acer 
TM4402WLMi

AMD Turion 64 
ML-30

1.6 GHz
(135 nits)

Acer 
TM4062WLMi

Intel Pentium M 
740

1.73 GHz
(142 nits)

Comparative 
Rating

Acer 
TM4402WLMi

AMD Turion 64 
ML-30

1.6 GHz
(135 nits)

Acer 
TM4062WLMi

Intel Pentium M 
740

1.73 GHz
(142 nits)

Comparative 
Rating

502 433 1.16
Adobe Photoshop Elements 4.0 with 
Adobe Premiere Elements 2.0 8.03 4.61 1.74

260 224 1.16 Apple iTunes 6.0.3 4.23 2.40 1.76
64 52 1.23 InterVideo iVideoToGo for PSP 1.01 0.55 1.84

203 165 1.23 Microsoft Windows Movie Maker 2.1 3.34 1.81 1.85
287 269 1.07 Pinnacle Studio 10 4.70 2.84 1.65

POWER CONSUMPTION RESULTS
(watt hours)

PERFORMANCE RESULTS
(seconds)

TESTS

 

Table 1: Results of performance and power measurement tests on the AMD-based Acer TravelMate 4402WLMi 
and the Intel-based Acer TravelMate 4062WLMi. Lower scores are better on both execution time and Workload 
Energy Consumption. 

Acer TM 
4404WLMi AMD 
Turion 64 ML-

34
1.8 GHz

(165 nits)

Acer 
TM4202WLMi
Intel Core Duo 

T2300
1.66 GHz
(174 nits)

Comparative 
Rating

Acer TM 
4404WLMi AMD 
Turion 64 ML-

34
1.8 GHz

(165 nits)

Acer 
TM4202WLMi
Intel Core Duo 

T2300
1.66 GHz
(174 nits)

Comparative 
Rating

444 249 1.78
Adobe Photoshop Elements 4.0 with 
Adobe Premiere Elements 2.0 7.67 2.66 2.88

248 131 1.89 Apple iTunes 6.0.3 4.10 1.40 2.93
57 42 1.36 InterVideo iVideoToGo for PSP 0.96 0.41 2.34

182 91 2.00 Microsoft Windows Movie Maker 2.1 3.19 1.00 3.19
261 172 1.52 Pinnacle Studio 10 4.44 1.71 2.60

PERFORMANCE RESULTS
(seconds)

TESTS

POWER CONSUMPTION RESULTS
(watt hours)

 
Table 2: Results of performance and power measurement tests on the AMD-based Acer TravelMate 4404WLMi 
and the Intel-based Acer TravelMate 4202WLMi. Lower scores are better on both execution time and Workload 
Energy Consumption. 
 

Test methodology 
This section details the methodologies we followed in testing the systems. 
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Configuration differences 
We purchased the built-to-order systems from www.newegg.com. We made them as identical as possible and 
as close in price as possible, but we could not avoid the following differences: 
 

• The motherboards for the AMD-based systems support only DDR RAM. These units contained DDR-
333 single channel SDRAM. The motherboard for the Intel-based TravelMate 4062WLMi system 
supports DDR2-533 dual channel SDRAM, which it contained. The motherboard for the Intel-based 
TravelMate 4202WLMi system supports DDR2-667 dual channel SDRAM, but it came configured with 
DDR2-533 dual channel SDRAM. 

• The hard drive controllers in the systems also differ. Though both are Ultra ATA/100 devices, the 
AMD-based systems use the ATI SB400 controller, while the Intel-based TravelMate 4062WLMi uses 
the Intel 82801FBM (ICH6-M) controller, and the Intel-based TravelMate 4202WLMi uses the Intel 
82801GHM (ICH7-M DH) controller. 

• The Intel-based TravelMate 4062WLMi system came with the integrated Intel GMA 900 video adapter 
with 128 MB of shared video RAM. The Intel-based TravelMate 4202WLMi came with the integrated 
Intel GMA 950 video adapter with 224 MB of shared video RAM. The AMD-based systems, by 
contrast, came with the PCI Express ATI Mobility Radeon X700 video adapters with 64 MB of 
dedicated video RAM. 

• The Intel-based systems came with the integrated Realtek High Definition audio adapter, while the 
AMD-based systems came with the integrated Realtek AC’97 audio adapter. 

• The AMD-based systems came with 1 S-Video out port, 1 IEEE1394 mini-port, and an integrated 
multimedia card reader. The Intel-based systems did not have any of these ports or readers.  

• The prices differ. (We exclude shipping and tax charges here.) The AMD-based TravelMate 
4402WLMi cost $1,099.00, while the comparison Intel-based TravelMate 4062WLMi cost $974.00. 
The AMD-based TravelMate 4404WLMi cost $1,199.00 when we purchased it (but was $1,149.00 on 
03/03/06), while the comparison Intel-based TravelMate 4202WLMi cost $1,274.00 when we 
purchased it (but was $1,099.00 on 03/03/06). 

 
Appendix A provides complete cost information for both systems, and Appendix B details their configurations. 

Initial setup 
When the systems arrived, we unpacked and set up each one. We went through the following process with 
each PC the first time we booted it: 
 

1. Pressed Next at the Welcome to Microsoft Windows screen. 
2. Selected United States, English and U.S. keyboard. Pressed Next. 
3. Selected Eastern Time. Pressed Next. 
4. Selected Yes, I accept the Microsoft End User License Agreement. Pressed Next. 
5. Selected Not right now to automatic updates, because our goal was to test each PC as it came out of 

the box. Pressed Next. 
6. Named each computer with its model (TM4062WLMi). 
7. Left each computer description blank. Pressed Next. 
8. Left Administrator password blank. Pressed Next. 
9. Selected No, don’t make this computer part of a domain. Pressed Next. 
10. Selected Skip during the An Internet connection could not be chosen part of the setup process. 

Pressed Next. 
11. Selected No, not at this time to registering with Microsoft. Pressed Next. 
12. Selected No, not at this time to setting up Internet access. Pressed Next. 
13. Entered User in the Your name field. Pressed Next. 
14. Selected Finish. 
15. Selected OK at the Acer recommendation to install an anti-virus application. 
16. Clicked on the Windows Security Center icon on the toolbar. 
17. Selected Change the way Security Center alerts me. 
18. Unchecked the Do not alert me about virus protection status. 
19. Unchecked the Do not alert me about firewall status. 
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20. Unchecked the Do not alert me about Windows Automatic Updates status. 
21. Selected OK and closed Windows Security Center. 
22. Right-clicked on the desktop and selected Properties. 
23. Under the Desktop tab we selected None for the background and clicked Apply. 
24. Under the Screen Saver tab we selected None for the Screen saver and clicked Apply. 
25. Also under the Screen Saver tab we selected the Power button. For the AMD-based systems we set 

the Power Schemes to Always On and all power settings listed under Plugged in to Never, then 
clicked Apply. The Intel-based systems came with Acer-customized power options, so we created a 
customized AC mode power scheme that was the equivalent of the AMD Always On power scheme 
and selected Never to all power settings. 

26. Inserted a blank DVD+R and checked Do not show this message again at the Acer eRecovery 
Management dialog. Pressed Enter. 

27. Pressed Next to start NTI factory default image creation process. 
28. Pressed OK at the Factory default image Backup disk1 finished dialog. 
29. Pressed Exit. 

 
We used Symantec’s Ghost product to capture an exact image of the hard disk directly to the internal DVD-
RW drive. Each time we ran a new benchmark or test on a machine, we used the Ghost image DVD to return 
that machine to the above configuration. After re-imaging, we installed the software necessary to run each 
test and rebooted. 
 
Before starting a test we allowed each laptop screen to warm up for at least 15 minutes. We did this by 
opening Microsoft Paint, pressing Ctrl-E, and setting the width and height larger than the screen resolution. 
We then pressed Ctrl-F to make the entire screen display a white background.  
 
Before each test run we used a Gossen Mavolux 5032C luminance meter on the white background to try to 
normalize the screen brightness between each pair of systems we were comparing. We did this because 
screen brightness can affect the amount of power a system consumes. For each pair of comparison systems 
we set the brightness to be as close as we could make it to the brightness of the dimmer of the two systems. 
Consequently, we set the AMD-based TravelMate 4402WLMi to approximately 135 nits and the Intel-based 
TravelMate 4062WLMi to approximately 142 nits. Similarly, we set the AMD-based TravelMate 4404WLMi to 
approximately 165 nits and the Intel-based TravelMate 4202WLMi to approximately 174 nits.  
 
Before each run, we manually deactivated each system’s wireless adapter using the external toggle button, 
because of the effect of the wireless adapter on power consumption.  
 
We rebooted before running each test. 
 
We monitored each system’s power consumption with an Intel Pentium 4 Extreme Edition 3.73 GHz host 
computer using the Intel Power Acquisition Recording Kit (iPARK).  
 
We followed these steps for setting up and running iPARK: 
 
iPARK setup 

1. Power off the laptop. 
2. Remove the battery from the laptop. 
3. Connect the iPARK DC power cable into the laptop’s power port. 
4. Plug both AC power cables from the iPARK device into the wall. Verify that the blue light on the 

Targus power brick is on. 
5. Connect the iPARK USB cable to the host computer. 
6. Turn on the iPARK power switch. A red light should glow. 
7. Turn on the host computer. 
8. Insert the iPARK software installation CD into the host computer, and install that software as follows: 

a. Click Next at the Welcome screen. 
b. Click Yes at the Software License Agreement screen. 
c. Click Next at the Choose Destination Location screen. 
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d. Click Next at the Select Program Folder screen. 
e. Uncheck View the README file and click Finish. 
f. Click OK to the Microsoft .NET Framework v1.1.x not found warning. 
g. Click Run at the next two Windows Security Warnings. 
h. Click Yes at the Microsoft .NET Framework 1.1 Setup screen. 
i. Select I agree at the license agreement and click Install. 
j. Click OK at the Installation Complete screen. 
k. Reboot the system. 
l. Insert the iPARK patch CD, and uncompress the files to the C:\iPARK directory. 
m. Select Yes To All when asked about overwriting files. 

9. Calibrate the iPARK software by going to Start->All Programs->Intel Power Acquisition Recording Kit-
>Intel Power Acquisition Recording Kit Calibration. 

10. Click OK at the PMD-1208LS (serial# 130) dialog. 
11. Highlight the Bd#0-PMD-1208LS (serial# 130), and click on the Configure icon found in the menu bar. 
12. Select 8 Single Ended from the no. of Channels field, and click OK. 
13. Exit the iPARK calibration tool. 
14. Power on the laptop, and make sure it is prepped to run a test. 
15. Start the Intel Power Acquisition Recording Kit Logging Tool. 
16. In the Name field, type a name that appropriately describes the platform and configuration. We used 

the following naming convention: test_processor_Runx (e.g., iTunes_CoreDuo_Run1). 
17. Use the same naming convention in the Log File field (e.g., iTunes_CoreDuo_Run1). 
18. Click the iPARK start button at the same time you start a test to begin logging immediately. 
19. Click the iPARK Stop button at the same time you stop a test. 
20. Click the Log File button to view the test log. 
21. Multiply the time (in seconds) that the system took to complete the test by the Average DC Power 

(Watts) score. Divide this number by 3600 to calculate the Workload Energy Consumption (WEC) in 
Watt-Hours. 

 
The following subsections summarize the steps we followed to obtain each of the test results in this report. 
 
Adobe Photoshop Elements 4.0 with Adobe Premiere Elements 2.0 
Intel provided the 30 slide files and the background.mp3 file this test uses. The slide files have the following 
key characteristics: 
 

• Resolution: 2592W x 1944H (180 dpi horizontal x 180 dpi vertical) 
• Size: Range from 369KB (377,000 bytes) to 2,667KB (2,730,944 bytes) 
• Bit depth: 24-bit color 

 
The background.mp3 file has the following key characteristics: 

• Length (hh:mm:ss): 00:02:52 
• Size: 3.28 MB (3,443,473 bytes) 

 
We performed the following steps on each PC to make it ready to run this test: 
 
Setup 

1. Reset the system to the base test image. 
2. Install Adobe Photoshop Elements 4.0 with Adobe Premiere Elements 2.0. Choose the following 

options during installation. 
a. Select Language, and click OK. 
b. Click Accept at the License Agreement screen. 
c. Click Install Adobe Photoshop Elements. 
d. Click Next at the Welcome screen. 
e. Click Accept at the License Agreement screen. 
f. Enter User Name, Organization, and Serial Number. Click Next. 
g. Click Next at the Destination Folder screen. 
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h. Accept defaults, and click Next at the file types you would like Photoshop Elements to open. 
i. Click Install at the Ready to Install the Program screen. 
j. Click Finish. 
k. Click Yes to reboot the system. 
l. Insert the Adobe Premiere Elements 2.0 DVD into the system. 
m. Select Language, and click OK. 
n. Click Accept at the License Agreement screen. 
o. Click Install Adobe Premiere Elements 2.0. 
p. Select language, and click OK. 
q. Click Next at the Welcome screen. 
r. Enter User Name, Organization, and Serial Number. Click Next. 
s. Select NTSC TV Format, and click Next. 
t. Click Next at the Destination Folder screen. 
u. Click Install at the Ready to Install the Program screen. 
v. Click Finish. 

3. Copy the 30 slides and the background.mp3 into the My Documents directory. 
 
Running the test 

1. Reboot the system. 
2. Launch Photoshop Elements by double-clicking the desktop icon. 
3. Select the Make Photo Creations icon. 
4. Click Register Later at the registration screen. 
5. Uncheck Automatically check for updates every month, and click Cancel. 
6. Click No to the Photoshop Elements Organizer pop up. 
7. From the top menu click File->Get Photos->From Files and Folders. 
8. Browse to the My Documents directory. 
9. Select all Slides and uncheck the box next to Automatically Fix Red Eyes. 
10. Click Get Photos. 
11. Check Don’t Show Again, and click OK at the Adobe pop up. 
12. Select all photos shown by pressing Ctrl-A. 
13. Click the Create button on the top menu. 
14. Select Slide Show to create a slide show, and click OK. 
15. Select 2 seconds for Static Duration and Transition Duration. Set Transition to Fade. Leave other 

options at their defaults, and click OK. 
16. Click the Add Media button, and select the Audio from Folder option. 
17. Browse to My Documents, and click Open on the background.mp3 file. 
18. From the top menu, click File->Save Slide Show Project. 
19. Name the file outdoors, and click Save. 
20. Click the Output icon. 
21. Choose Burn to Disc, and select the DVD option. Click OK. 
22. Click Save to create the outdoors.wmv file while at the same time starting a stopwatch and the iPARK 

device. 
23. A progress bar will appear. 
24. Stop the stopwatch and iPARK device when the progress bar disappears. 
25. Adobe Premiere Elements 2.0 will automatically launch after the creation of the outdoors.wmv file is 

complete. 
26. Click Do Not Register. 
27. Name the New Project photoDVD. 
28. Browse to make the Save In directory to My Videos ,and click OK. 
29. Select the Adventure Template, and check the radio button that says Apply a Template for a DVD 

with Menus. 
30. Click OK. 
31. Click No at the Missing DVD Markers message. 
32. Click Burn DVD. 
33. Select the Burn to option to be Folder. 
34. Click Burn while at the same time starting a stopwatch and the iPARK device. 
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35. A progress bar will appear. 
36. When the progress bar says Export Completed, stop the stopwatch and the iPARK device. 
37. Add the two times to get a combined total time. 
38. Close Adobe Premiere Elements 2.0, and select No to saving changes. 
39. Close the Adobe Photoshop Elements 4.0 window, check Don’t Show Again, and click OK at the slide 

show complete dialog. 
40. Right-click the slideshow you just created, and select Delete from Catalog. 
41. Click OK. 
42. Browse to My Documents, and delete the .wmv file and any DVD files you created. 
43. Empty the Recycle Bin. 
44. Repeat two times. 

 
We report the combined time, in seconds, that Photoshop Elements 4.0 took to convert the files to .wmv 
format with the time that Premiere Elements 2.0 took to burn the contents to a folder.  
 
Apple iTunes 6.0.3 
Intel provided the file, mixTest.wav, this test uses. The file has the following key characteristics: 
 

• Length (hh:mm:ss): 01:09:29 
• Size: 701 MB (735,557,138 bytes) 

 
We performed the following steps to run this test: 
 
Setup 

1. Reset the system to the base test image. 
2. Download iTunes 6.0.3 from http://www.apple.com/itunes/download/.  
3. Launch the iTunes installer with setup defaults. 

a. Choose Setup Language, and click OK. 
b. Click Next at the Welcome to iTunes 6 Installer screen. 
c. Select I accept the terms of the license agreement, and click Next. 
d. Click Next at the About iTunes screen. 
e. Accept the defaults, and click Next at the Setup Type screen. 
f. Click Next at the Choose Destination Location screen. 
g. Click Next at the Born to be together screen. 
h. Click Finish at the Installation Successful screen. 

4. Copy the mixTest.wav file to My Music. 
5. Launch iTunes via its desktop icon. 
6. Click Agree at the License Agreement. 
7. Use the following choices for iTunes Setup Assistant. 

a. Click Next at the Welcome to iTunes screen. 
b. Uncheck the Add MP3 and AAC files option. 
c. Uncheck the Add WMA files option, and click Next. 
d. Choose No, I’ll change the file and folder names myself, and click Next at the Keep iTunes Music 

Folder Organized screen. 
e. Choose No, take me to my iTunes Library, and click Finish at the iTunes Music Store screen. 

8. Under the Edit menu, select Preferences. 
9. Click the Advanced tab. 
10. Click the Importing tab. 
11. From the drop-down menu next to Import Using, choose MP3 Encoder. 
12. Uncheck Play songs while importing. 
13. Uncheck Create filenames with track number. 
14. Click OK. 
15. Exit iTunes. 

 
Running the test 

1. Reboot the system. 
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2. Launch iTunes via its desktop icon. 
3. From the file menu, select Add File to Library. 
4. Browse to the My Music directory, and choose the test file (mixTest.wav) to add to the library. 
5. Click Open after you select the file. 
6. iTunes will now show this file in its song-list pane. 
7. Right-click the file, and select the option Convert Selection to MP3. Start the iPARK device at the 

same time you start Convert Selection to MP3. 
8. During the encoding process, iTunes shows a new mixTest file being created with an Incomplete in 

the Time column beside it. 
9. When the converting progress bar disappears, stop the iPARK device. iTunes has finished the 

encoding. 
10. Use Windows Explorer to locate the output mixTest.mp3 file in the iTunes directory within the My 

Music folder. 
11. Right-click the file, and choose Properties. 
12. Calculate the difference between the file Created and Modified times. This time is how long iTunes 

took to encode the file to .mp3 format. 
13. Highlight the two mixTest items in the iTunes Library. 
14. Right click, and select Clear. 
15. Check the box that says Do not ask me again, and click Remove. 
16. Click Move to Recycle Bin. 
17. Empty the Recycle Bin. 
18. Repeat two times. 

 
We report the time, in seconds, that iTunes took to convert the file. The time we report is the difference of the 
file creation and modification times. 
 
InterVideo iVideoToGo for PSP 
Intel provided the file, kitesurfing.avi, this test uses. The file has the following key characteristics: 
 

• Length (mm:ss): 02:01 
• Size: 416 MB (436,644,352 bytes) 
• Video resolution: 720 x 480 

 
We performed the following steps to run this test: 
 
Setup 

1. Reset the system to the base test image. 
2. Download iVideoToGo for PSP from http://www.intervideo.com/jsp/iVideoToGo_Profile.jsp.  
3. Launch the iVideoToGo for PSP installer as follows. 

a. Click Next at the Welcome to iVideoToGo Setup screen. 
b. Click Yes at the License Agreement screen. 
c. Click Next at the Choose Destination Location screen. 
d. Click Next at the Select Program Folder screen. 
e. Click Next at the Third Party Application Setup screen. 
f. Uncheck the options for installing Google Toolbar and Google Desktop Search, and click Next. 
g. Click Finish to reboot the system. 

4. Copy the kitesurfing.avi file to My Documents. 
5. Launch iVideoToGo for PSP via its desktop icon. 
6. Select Please remind me again in 5 days at the iVideoToGo Trial screen, and click Continue. 
7. Select Do not display this dialog again at the Registration screen, and click Continue. 
8. Exit iVideoToGo. 

 
Running the test 

1. Reboot the system. 
2. Launch iVideoToGo for PSP via its desktop icon. 
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3. Select Convert File from the top menu. 
4. Click the top right icon, Add video from local. 
5. Browse to the My Documents directory, and choose the test file (kitesurfing.ave). 
6. Click Open after you select the file. 
7. Click the Browse target icon to the right of the Target field. 
8. Select the Desktop as the Target directory, and click OK. 
9. Click the Start Copying icon located near the bottom right of the screen. 
10. Click Yes to create the target path while at the same time starting a stopwatch and the iPARK device. 
11. During the encoding process, iVideoToGo a progress bar. 
12. When the Copy operation completed pop-up appears, stop the stopwatch and the iPARK device. 

iVideoToGo has finished the encoding. 
13. The stopwatch time is how long iVideoToGo took to encode the file to PSP format. 
14. Exit iVideoToGo. 
15. Select Yes you want to Exit the program. 
16. Select No to saving the changes made to the project. 
17. Delete the MP_ROOT directory on the desktop. 
18. Empty the Recycle Bin. 
19. Repeat two times. 

 
We report the time, in seconds, that iVideoToGo for PSP took to convert the file.  
 
Microsoft Windows Movie Maker 2.1 
This application is part of Windows XP Service Pack 2, so we did not need to install it. 
 
Intel provided the file, kitesurfing.avi, this test uses. The file has the following key characteristics: 
 

• Length (mm:ss): 02:01 
• Size: 416 MB (436,644,352 bytes) 
• Video resolution: 720 x 480 

 
We performed the following steps to run this test: 
 
Setup 

1. Reset the system to the base test image. 
2. Copy the kitesurfing.avi to the desktop 

 
Running the test 

1. Reboot the system. 
2. Launch Windows Movie Maker. 
3. From the top menu, click File->Import into Collections. 
4. Browse to the kitesufing.avi file on the desktop, and click Import. 
5. Drag the five scenes into the bottom Timeline. 
6. From the top menu, click File->Save Movie File. 
7. Select My Computer, and click Next. 
8. Leave the default options, and click Next. 
9. Click Next while at the same time starting the iPARK device. 
10. A progress bar will appear 
11. Stop the iPARK device when the Save Movie dialog shows Finish. 
12. Uncheck the box next to Play movie when I click Finish, and click Finish. 
13. Exit Windows Movie Maker 2.1, and select No to save changes. 
14. Use Windows Explorer to locate the output movie.wma file in the My Videos directory. 
15. Right-click the file, and choose Properties. 
16. Calculate the difference between the file Created and Modified times. 
17. Delete the movie.wma file. 
18. Empty the Recycle Bin. 
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19. Repeat two times.  
 
We report the time, in seconds, that Microsoft Windows Movie Maker 2.1 took to convert the file. The time we 
report is the difference of the file creation and modification times. 
 
Pinnacle Studio 10 
Intel provided the file, kitesurfing.avi, this test uses. The file has the following key characteristics: 
 

• Length (mm:ss): 2:01 
• Size: 416 MB (436,644,352 bytes) 
• Video resolution: 720 x 480 

 
We performed the following steps to run this test: 
 
Setup 

1. Reset the system to the base test image. 
2. Install Pinnacle Studio 10 as follows: 

a. Choose Setup Language, and click Next. 
b. Enter First Name, Last Name, Email Address, and Serial Number. Uncheck I would like to receive 

emails. 
c. Click Remind Me Later. 
d. Click Remind Me Later at the 4 good reasons to register screen. 
e. Select I accept the terms of the license agreement, and click Next. 
f. Select Typical, and click Next. 
g. Click Next at the Start Copying Files screen. 
h. Insert CD 2, and click OK. 
i. Click No to inserting Bonus disc #3. 
j. Click Yes to creating a shortcut on the desktop. 
k. Click Finish to reboot the system. 
l. Insert CD 3. It will autorun. 
m. Select Language, and click Next. 
n. Click Next at the Welcome screen. 
o. Click Yes at the License Agreement screen. 
p. Select Yes at the Choose Destination Location screen. 
q. Accept defaults, and click Next at the Select Components screen. 
r. Click Finish. 

3. Download and install patch 10.5 from 
http://www.pinnaclesys.com/PublicSite/us/Support/Consumer+Support/ 
a. Select language, and click OK. 
b. Select I accept the terms of the license agreement, and click Next. 
c. Click Next at the Welcome screen. 
d. Click Finish to reboot the system. 

4. Copy the kitesurfing.avi file to My Documents. 
 
Running the test 

1. Reboot the system. 
2. Launch Pinnacle Studio 10 via its desktop icon. 
3. Click the icon for Pinnacle Studio Plus. 
4. Click Remind Me Later at the registration screen. 
5. Click Remind Me Later at the 4 good reasons to register screen. 
6. Click No to automatically check for updates. 
7. Click OK to the message about periodically checking for updates. 
8. Click the icon whose description is Select video files from a different folder. 
9. Browse to My Documents and open the kitesurfing.avi file. 
10. Drag the four scenes into the bottom My Movie section. 
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11. Click the Make Movie tab. 
12. Select the Create a disc from current project (VCD,SVCD,DVD) icon on the top left of the window. 
13. Click the Settings button. 
14. Under Audio compression select MPA (MPEG-1 Layer 2). 
15. The Bit rate should be 8500 Kbits/sec. If not, set it to that value. 
16. Under Video quality / disc usage, select Custom. 
17. Under Burn options, select Create disc content but don’t burn. 
18. Under Image type, select VIDEO_TS folder. 
19. Click OK. 
20. Click the Select folder to use for auxiliary files icon located near the top middle section of the window. 
21. Browse to My Videos, and click OK. 
22. Click the green Create image button. 
23. Browse to the My Videos directory. 
24. Click OK while starting the stopwatch and the iPARK device at the same time. 
25. A progress bar will appear. 
26. Stop the stopwatch and iPARK device when dialog reads Disc content created successfully. 
27. Exit Pinnacle Studio 10, and click No to save changes. 
28. Browse to My Documents, and delete the kitesurfing files. 
29. Browse to the My Videos directory, and delete the VIDEO_TS folder. 
30. Empty the Recycle Bin. 
31. Repeat two times. 

 
We report the time, in seconds, that Pinnacle Studio 10 took to burn the contents to a folder. 
 



Principled Technologies, Inc.: Mobile PC Performance: Built-To-Order Systems  12 
www.principledtechnologies.com 
 

Appendix A: Test system price and purchase information 
 
We purchased the four Acer laptop systems on February 9, 2006 via www.newegg.com.  
 
Figure 1 below presents the SKU and price information for the laptops. 
 
System Acer TravelMate 

4402WLMi 
Acer 

TravelMate 
4062WLMi 

Acer TravelMate 
4404WLMi 

Acer TravelMate 
4202WLMi 

Processor AMD Turion 64 
ML-30 

Intel Pentium M 
740 

AMD Turion 64 
ML-34 

Intel Core Duo 
T2300 

Processor frequency 1.6 GHz 1.73 GHz 1.8 GHz Dual-Core 1.66 
GHz 

Unit price ($) 1,099.00 974.00 1,199.00 1,274.00
Tax ($) (1) 0.00 0.00 0.00 0.00
Shipping ($)(2) 13.46 13.46 13.46 13.46
Total we paid ($) 1,112.46 987.46 1,212.46 1,287.46

Figure 1: Purchase information for the four Acer laptops. 

Notes: 
(1) www.newegg.com did not add any tax.  
(2) We assigned each system one fourth of the total shipping charge we paid for this order. 
 



Principled Technologies, Inc.: Mobile PC Performance: Built-To-Order Systems  13 
www.principledtechnologies.com 
 

Appendix B: Test system configuration information 
This appendix provides detailed configuration information about the four test systems.  
 

SYSTEM 
Acer 

TravelMate 
4402WLMi 

Acer 
TravelMate 
4062WLMi 

Acer 
TravelMate 
4404WLMi 

Acer 
TravelMate 
4202WLMi 

General     
Processor and OS kernel: 

(physical, core, logical) / (UP, 
MP) 

1P1C1L / UP 1P1C1L / UP 1P1C1L / UP 1P2C2L / MP 

Number of physical processors 1 1 1 1 
Single/Dual Core processors Single Single Single Dual 
Processor HT Status NA NA NA NA 
System power management 

policy 
Windows Power 
Management-

Portable / Laptop 

Acer ePower 
Management 

Word Processing 

Windows Power 
Management-

Portable / Laptop 

Acer ePower 
Management 

Word Processing 

Processor power-saving option 
AMD 

PowerNow! 
Technology 

Enhanced Intel 
SpeedStep 
Technology 

AMD 
PowerNow! 
Technology 

Enhanced Intel 
SpeedStep 
Technology 

System dimensions (length x 
width x height) 

14-5/16 x 10-
7/8 x 1-1/2 

(min) 11-3/4 
(max) 

14-5/16 x 10-
3/4 x 1-1/2 

(min) 11-3/4 
(max) 

14-5/16 x 10-
7/8 x 1-1/2 

(min) 11-3/4 
(max) 

14-1/8 x 10-1/2 
x 1-9/16 (min) 
11-9/16 (max) 

System weight 6 lbs. 12 oz. 6 lbs. 1 oz. 6 lbs. 15 oz. 5 lbs. 14 oz. 
CPU     
Vendor AMD Intel AMD Intel 
Name Turion 64 Pentium M Turion 64 Core Duo 
Model number ML-30 740 ML-34 T2300 
Stepping SH8-E5 C0 SH8-E5 C0 
Socket type and number of pins Socket 754 mPGA-479M Socket 754 mPGA-479M 
Core frequency (GHz) 1.6 1.73 1.8 1.66 

Front-side bus frequency 
1600MHz 

HyperTransport 
Technology 

533MHz 
1600MHz 

HyperTransport 
Technology 

667MHz 

L1 Cache 64 KB + 64 KB 32 KB + 32 KB 64 KB + 64 KB 32 KB + 32 KB 
L2 Cache 1 MB 2 MB 1 MB 2 MB 
Platform     
Vendor Acer Acer Acer Acer 

Motherboard model number TravelMate 
4400 Luganoll TravelMate 

4400 Grapevine 

Motherboard chipset ATI RS482 
Intel 

i915GMS/i910
GML 

ATI RS482 Intel i945GM 

Motherboard revision number A NA A NA 
System/motherboard serial 

number 
LXT780602355
1065A8KS00 

LXTAK0607955
110D16EM00 

LXT780609155
20279FKS00 

LXTAV0604060
112331ED00 

Bios name and version Phoenix V1.18 Acer 3A05 Phoenix V1.18 Acer V1.30 
BIOS settings Setup default Setup default Setup default Setup default 
Memory module(s)     

Vendor and model number Infineon 
64D64020HBDL6C

Nanya Technology 
NT256T64UH4A0F

N-37 

Hyundai Electronics 
HYMD564M646B6-

J 

Samsung M4 
70T6554CZ3-CD5 

Type DDR PC2700 DDR-2 PC4200 DDR PC2700 DDR-2 PC4200 
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Speed (MHz) 166 266 166 266 
Speed running in the system 

(MHz) 333 533 333 533 

Timing/Latency (tCL-tRCD-tRP-
tRASmin) 2.5-3-3-7 4-4-4-12 2.5-3-3-7 4-4-4-11 

Size 512 MB 512 MB 1 GB 1 GB 
Number of memory module(s) 1 x 512 MB 2 x 256 MB 2 x 512 MB 2 x 512 MB 
Chip organization (Single-sided, 

Double-sided) Double-sided Single-sided Double-sided Double-sided 

Channel (Single/Dual) Single Dual Single Dual 
Hard disk     

Vendor and model number Samsung 
HM100JC 

Seagate 
ST9100825A 

Seagate 
ST9120824A 

Seagate 
ST9100824A 

Size 100 GB 100 GB 120 GB 100 GB 
Buffer Size 8 MB 8 MB 8 MB 8 MB 
RPM 5400 4200 4200 5400 
Type Ultra ATA 100 Ultra ATA 100 Ultra ATA 100 Ultra ATA 100 

Controller ATI SB400 Intel 82801FBM 
(ICH6-M) ATI SB400 

Intel 
82801GHM 

(ICH7-M DH) 

Driver ATI 
5.10.1000.5 Intel 6.0.0.1013 ATI 

5.10.1000.5 Intel 7.0.0.1020 

Operating system     

Name Windows XP 
Professional 

Windows XP 
Professional 

Windows XP 
Professional 

Windows XP 
Professional 

Build number 2600 2600 2600 2600 
Service pack 2 2 2 2 
File system FAT32 FAT32 FAT32 FAT32 

Kernel 
ACPI 

Uniprocessor 
PC 

ACPI 
Uniprocessor 

PC 

ACPI 
Uniprocessor 

PC 

ACPI 
Multiprocessor 

PC 
Language English English English English 
Microsoft DirectX version DirectX 9.0c DirectX 9.0c DirectX 9.0c DirectX 9.0c 
Graphics     

Vendor and model number ATI Mobility 
Radeon X700 Intel GMA 900 ATI Mobility 

Radeon X700 Intel GMA 950 

Type (P=PCI Express, A=AGP 
8X, I=Integrated) P I P I 

Chipset X700 

915GM/GMS,9
10GML 
Express 

Chipset Family 

X700 
I945GM 
Express 

Chipset Family 

BIOS version 
BK-ATI 

VER009.010.00
1.000 

1219 
BK-ATI 

VER009.010.00
1.000 

1264 

Memory size 64 MB 128 MB Shared 64 MB 224 MB Shared 
Resolution 1280 x 800 1280 x 800 1280 x 800 1280 x 800 

Driver ATI 
6.14.10.6525 

Intel 
6.14.10.4363 

ATI 
6.14.10.6525 

Intel 
6.14.10.4436 

Sound card/subsystem     

Vendor and model number Realtek AC’97 
Audio 

Realtek High 
Definition Audio 

Realtek AC’97 
Audio 

Realtek High 
Definition Audio 
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Driver 
Realtek 

Semiconductor 
5.10.0.5900 

Realtek 
Semiconductor 

5.10.0.5148 

Realtek 
Semiconductor 

5.10.0.5900 

Realtek 
Semiconductor 

5.10.0.5191 
Ethernet     

Vendor and model number 

Realtek 
RTL8169/8110 
Family Gigabit 

Ethernet 

Realtek 
RTL8139/810x 

Family Fast 
Ethernet 

Realtek 
RTL8169/8110 
Family Gigabit 

Ethernet 

Broadcom 440x 
10/100 

integrated 
controller 

Driver 

Realtek 
Semiconductor 
5.620.1202.200

4 

Realtek 
Semiconductor 
5.621.304.2005 

Realtek 
Semiconductor 
5.620.1202.200

4 

Broadcom 
4.37.0.0 

Wireless     

Vendor and model number Broadcom 
802.11g 

Intel 
Pro/Wireless 

2200BG 

Broadcom 
802.11g 

Intel 
Pro/Wireless 

3945ABG 

Driver Broadcom 
3.100.46.0 Intel 9.0.1.9 Broadcom 

3.100.46.0 Intel 10.1.0.11 

Modem     

Vendor and model number 

CXT SoftV90 
Data Fax 

Modem with 
SmartCP 

CXT HDAUDIO 
Soft Data Fax 
Modem with 

SmartCP 

CXT SoftV90 
Data Fax 

Modem with 
SmartCP 

CXT HDAUDIO 
Soft Data Fax 
Modem with 

SmartCP 
Driver CXT 7.20.0.0 CXT 7.31.0.50 CXT 7.20.0.0 CXT 7.34.0.0 
Optical drive(s)     

Vendor and model number TSSTcorp TS-
L632B 

Lite On SOSW-
833S 

TSSTcorp TS-
L632B LG GSA-4082N 

Type (CD-ROM, CD-RW, DVD-
ROM, DVD-W) DVD-RW DVD-RW DVD-RW DVD-RW 

USB ports     
Number 4 3 4 4 
Type USB 2.0 USB 2.0 USB 2.0 USB 2.0 

Other 
MMC/SD/SM/M

S/MS Pro/xD 
Card Reader 

NA 
MMC/SD/SM/M

S/MS Pro/xD 
Card Reader 

NA 

IEEE 1394 ports     
Number 1 0 1 0 
Monitor     
LCD type WXGA WXGA WXGA WXGA 
Screen size 15.4” 15.4” 15.4” 15.4” 
Refresh rate 60 60 60 60 
Battery     

Type 
Sanyo BTP-

96H1 Lithium-
Ion 

Sanyo 
4UR18650F-1-
QC192 Lithium-

Ion 

Sanyo BTP-
98H1 Lithium-

Ion 

Sanyo 
BATBL50L6 
Lithium-Ion 

Size (length x width x height) 5-1/2 x 3-1/2 x 
7/8 

8-5/16 x 2-3/4 x 
7/8 

5-1/2 x 3-1/2 x 
7/8 

5-3/8 x 3-1/2 x 
3/4 

Rated capacity 4400mAh / 
14.8V (65Whr) 

2000mAh / 
14.8V (30WHr) 

4400mAh / 
14.8V (65WHr) 

4000mAh / 
11.1V (44WHr) 

Weight 15 oz. 9 oz. 14 oz. 11 oz. 

Figure 2: System configuration information for the four test systems. 
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Appendix C: Detailed test results 
This appendix provides the complete performance and power measurement results of all the test runs. The 
nits figure under each system name is the screen brightness at which we tested the system. All performance 
results are in seconds. In the power measurements, WEC stands for Workload Energy Consumption, which 
we report in Watt-hours, and ADC stands for Average DC Power, which we report in Watts. 
 

TESTS 
Acer TM4402WLMi 

AMD Turion 64 
ML-30 1.6 GHz 

(135 nits) 

Acer TM4062WLMi
Intel Pentium M 

740 1.73 GHz 
(142 nits) 

Adobe Photoshop Elements 4.0 with Adobe Premiere 
Elements 2.0 performance results   

Photoshop Elements 4.0 slideshow movie creation - Run 1 181 145 
Premier Elements 2.0 DVD burn - Run 1 321 287 
Total Time (seconds) – Run 1 502 432 
Photoshop Elements 4.0 slideshow movie creation - Run 2 180 145 
Premier Elements 2.0 DVD burn - Run 2 321 289 
Total Time (seconds) – Run 2 501 434 
Photoshop Elements 4.0 slideshow movie creation - Run 3 181 145 
Premier Elements 2.0 DVD burn - Run 3 322 288 
Total Time (seconds) – Run 3 503 433 

Adobe Photoshop Elements 4.0 with Adobe Premiere 
Elements 2.0 power measurements   

Photoshop Elements 4.0 slideshow movie creation ADC - 
Run 1 

58.24 38.55 

Photoshop Elements 4.0 slideshow movie creation – WEC 
- Run 1 

2.93 1.55 

Premier Elements 2.0 DVD burn – ADC - Run 1 57.19 37.83 
Premier Elements 2.0 DVD burn – WEC - Run 1 5.10 3.02 
Total WEC - Run 1 8.03 4.57 
Photoshop Elements 4.0 slideshow movie creation – ADC 
- Run 2 

58.58 38.71 

Photoshop Elements 4.0 slideshow movie creation – WEC 
- Run 2 

2.93 1.56 

Premier Elements 2.0 DVD burn - ADC - Run 2 58.36 38.29 
Premier Elements 2.0 DVD burn – WEC - Run 2 5.20 3.07 
Total WEC - Run 2 8.13 4.63 
Photoshop Elements 4.0 slideshow movie creation – ADC 
- Run 3 

58.19 38.64 

Photoshop Elements 4.0 slideshow movie creation – WEC 
- Run 3 

2.93 1.56 

Premier Elements 3.0 DVD burn – ADC - Run 3 57.37 38.09 
Premier Elements 3.0 DVD burn – WEC - Run 3 5.13 3.05 
Total WEC - Run 3 8.06 4.61 

Apple iTunes 6.0.3 performance results   
iTunes 6 - Run 1 260 225 
iTunes 6 - Run 2 260 224 
iTunes 6 - Run 3 260 224 

Apple iTunes 6.0.3 power measurements   
ADC - Run 1 58.55 38.55 
WEC - Run 1 4.23 2.41 
ADC - Run 2 58.50 38.50 
WEC - Run 2 4.23 2.40 
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ADC - Run 3 58.46 38.52 
WEC - Run 3 4.22 2.40 

InterVideo iVideoToGo for PSP performance results   
iVideoToGo for PSP - Run 1 64 53 
iVideoToGo for PSP - Run 2 63 52 
iVideoToGo for PSP - Run 3 64 52 

InterVideo iVideoToGo for PSP power measurements   
ADC - Run 1 56.48 37.98 
WEC - Run 1 1.00 0.56 
ADC - Run 2 57.76 38.37 
WEC - Run 2 1.01 0.55 
ADC - Run 3 56.97 38.07 
WEC - Run 3 1.01 0.55 

Microsoft Windows Movie Maker 2.1 performance results   
Windows Movie Maker 2.1 - Run 1 203 165 
Windows Movie Maker 2.1 - Run 2 203 165 
Windows Movie Maker 2.1 - Run 3 203 164 

Microsoft Windows Movie Maker 2.1 power measurements   
ADC - Run 1 58.30 39.42 
WEC - Run 1 3.29 1.81 
ADC - Run 2 58.07 39.31 
WEC - Run 2 3.27 1.80 
ADC - Run 3 59.29 39.23 
WEC - Run 3 3.34 1.79 

Pinnacle Studio 10 performance results   
Studio 10 - Run 1 286 264 
Studio 10 - Run 2 287 269 
Studio 10 - Run 3 288 273 

Pinnacle Studio 10 power measurements   
ADC – Run 1 57.12 37.84 
WEC - Run 1 4.54 2.77 
ADC – Run 2 58.99 37.96 
WEC - Run 2 4.70 2.84 
ADC – Run 3 57.43 37.61 
WEC - Run 3 4.59 2.85 

Table 3: Detailed results of performance and power measurement tests on the AMD-based Acer TravelMate 
4402WLMi and the Intel-based Acer TravelMate 4062WLMi. Lower scores are better in all cases. 

 

TESTS 
Acer TM4404WLMi 

AMD Turion 64 
ML-34 1.8 GHz 

(165 nits) 

Acer TM4202WLMi
Intel Core Duo 
T2300 1.66 GHz 

(174 nits) 
Adobe Photoshop Elements 4.0 with Adobe Premiere 
Elements 2.0 performance results   

Photoshop Elements 4.0 slideshow movie creation - Run 1 161 80 
Premier Elements 2.0 DVD burn - Run 1 282 169 
Total Time - Run 1 443 249 
Photoshop Elements 4.0 slideshow movie creation - Run 2 161 81 
Premier Elements 2.0 DVD burn - Run 2 284 169 
Total Time - Run 2 445 250 
Photoshop Elements 4.0 slideshow movie creation - Run 3 161 80 
Premier Elements 2.0 DVD burn - Run 3 283 169 
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Total Time - Run 3 444 249 
Adobe Photoshop Elements 4.0 with Adobe Premiere 
Elements 2.0 power measurements   

Photoshop Elements 4.0 slideshow movie creation - ADC - 
Run 1 

62.56 38.39 

Photoshop Elements 4.0 slideshow movie creation - WEC - 
Run 1 

2.80 0.85 

Premier Elements 2.0 DVD burn - ADC - Run 1 61.77 38.57 
Premier Elements 2.0 DVD burn - WEC - Run 1 4.84 1.81 
Total WEC - Run 1 7.64 2.66 
Photoshop Elements 4.0 slideshow movie creation - ADC - 
Run 2 

63.01 38.31 

Photoshop Elements 4.0 slideshow movie creation - WEC - 
Run 2 

2.82 0.86 

Premier Elements 2.0 DVD burn - ADC - Run 2 61.53 38.30 
Premier Elements 2.0 DVD burn - WEC - Run 2 4.85 1.80 
Total WEC - Run 2 7.67 2.66 
Photoshop Elements 4.0 slideshow movie creation - ADC - 
Run 3 

63.02 38.59 

Photoshop Elements 4.0 slideshow movie creation - WEC - 
Run 3 

2.82 0.86 

Premier Elements 3.0 DVD burn - ADC - Run 3 61.67 37.77 
Premier Elements 3.0 DVD burn - WEC - Run 3 4.85 1.77 
Total WEC - Run 3 7.67 2.63 

Apple iTunes 6.0.3 performance results   
iTunes 6 - Run 1 248 132 
iTunes 6 - Run 2 248 131 
iTunes 6 - Run 3 248 131 

Apple iTunes 6.0.3 power measurements   
ADC - Run 1 59.46 38.11 
WEC - Run 1 4.10 1.40 
ADC - Run 2 59.18 38.37 
WEC - Run 2 4.08 1.40 
ADC - Run 3 59.21 38.19 
WEC - Run 3 4.08 1.39 

InterVideo iVideoToGo for PSP performance results   
iVideoToGo for PSP - Run 1 58 43 
iVideoToGo for PSP - Run 2 57 42 
iVideoToGo for PSP - Run 3 57 42 

InterVideo iVideoToGo for PSP power measurements   
ADC - Run 1 60.69 35.33 
WEC - Run 1 0.98 0.42 
ADC - Run 2 60.91 35.52 
WEC - Run 2 0.96 0.41 
ADC - Run 3 60.94 35.31 
WEC - Run 3 0.96 0.41 

Microsoft Windows Movie Maker 2.1 performance results   
Windows Movie Maker 2.1 - Run 1 183 90 
Windows Movie Maker 2.1 - Run 2 182 91 
Windows Movie Maker 2.1 - Run 3 182 92 

Microsoft Windows Movie Maker 2.1 power measurements   
ADC - Run 1 62.91 39.63 
WEC - Run 1 3.20 0.99 
ADC - Run 2 63.06 39.55 
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WEC - Run 2 3.19 1.00 
ADC - Run 3 63.13 39.64 
WEC - Run 3 3.19 1.01 

Pinnacle Studio 10 performance results   
Studio 10 - Run 1 255 173 
Studio 10 - Run 2 261 172 
Studio 10 - Run 3 261 171 

Pinnacle Studio 10 power measurements   
ADC - Run 1 60.61 35.95 
WEC - Run 1 4.29 1.73 
ADC - Run 2 61.31 35.71 
WEC - Run 2 4.44 1.71 
ADC - Run 3 61.24 36.28 
WEC - Run 3 4.44 1.72 

Table 4: Detailed results of performance and power measurement tests on the AMD-based Acer TravelMate 
4404WLMi and the Intel-based Acer TravelMate 4202WLMi. Lower scores are better in all cases. 

 

Disclaimer of Warranties; Limitation of Liability: 
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY 
OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, 
EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS 
OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR 
ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED 
TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER 
FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING 
PROCEDURE OR RESULT.  
 
IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, 
EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S 
SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN. 

 

Principled Technologies, Inc. 
4813 Emperor Blvd., Suite 100 

Durham, NC 27703 
www.principledtechnologies.com 
info@principledtechnologies.com 

Principled Technologies is a registered trademark of Principled Technologies, Inc. 
All other product names are the trademarks of their respective owners 
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